ePM Quick Reference Guide #042
Creating and Managing CPM Schedules

WHAT IS...

Schedules

The ePM Schedule application is an integral part of the Portfolio Management suite of applications. Start
and end dates for each summary event, milestone, and task can be established. Also, the ePM
Administrator can set up email alerts and ePM notifications for when a task exceeds the approved
milestone. Project schedules can be viewed at the project level, or rolled up into a Program-level Critical
Path Method (CPM) or Collaborative Gantt view, complete with collapsible/expandable visibility into the
schedules, resources, linked WBS structure, attached documents, tasks, milestones, cost summaries,
progress percentage complete, and more summary detailed information. ePM Schedule can import file
from Primavera, Microsoft and other applications. Like other ePM documents, the Schedule document
has workflows, activity logs and attachments available. Schedules can also be cross linked to other ePM
documents, such as RFI's, Submittals, Drawings, etc., to provide easy cross reference.

Calendars

The ePM calendar document allows the user to define normal working hours for a project schedule. On
the calendar, exceptions can be set for particular non working days. Customized calendars for each
project can be created, though each schedule document is limited to a single calendar.

Resources

The Resource document enables the creation of resources and the ability to link these resources to tasks
in the Gantt chart. A user can also associate a contact with a resource in the Resource document. When
a contact is not associated with a resource, the resource is a generic resource. Generic resources are
useful for denoting material resources.

e General Contractor
e Construction Manager
e Project Manager

1. Log into ePM as a user with security permissions that include the Schedule-Creator or Schedule-
Approver role.

2. Navigate to your project, then to PM Tools > Schedules > Schedules.
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= PM Tools

Project Manager Quick Links
Project Management
= Schedules

PM Schedule

Schedules

3. Click the dropdown arrow next to the New button and click Schedule.

PM Schedule

Schedule |

4. A blank schedule document opens. Enter a Title for the schedule. In the ‘Start Date’ and ‘End
Date’ fields, enter the overall start and end dates for the schedule.

Genera

SCHEDULE: New Document

Main | Properties

[= SUMMARY

Current State Draft Start Date
Title Finish Date
Number Schedule
Title * I
Mumber Schedule -
s
Start Date * [E9N
Finish Date * BN
Estimated Work Hours 0
priority [
Activity Code Group |
Calendar |
Company Contact
Managing Contact
I I

5. The ‘Activity Code Group’ allows assignment of metadata to each task or milestone in the
schedule. This additional data can be useful in reports related to the schedule.

6. Inthe ‘Calendar field, you can select a single calendar that designates working days for all tasks
in the schedule. You also can assign separate calendars to each task in the schedule.
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Note:- the Schedule document shown at left contains basic information about the schedule. Open
the Gantt views to enter tasks, change durations, assign resources, set baselines, etc.

7. Finally, click the ‘Save’ button to save the schedule.
8. There are three ways to open the schedule in Gantt view:

a. From the register, check the box next to the schedule (or schedules) you wish to view,
then click ‘Tools’ and select to either open in Collaborative or CPM Gantt view.

New V| Delete | Tools A| Sharing | Print ¥ | Expart Refresh  Help

Find Results éDpen Selected in Collaborative Gantt v|

D Number Open Selected in CPM Gantt

_le
als [
L nira
als — Jcowe

] 32 GC Contract
O 33 GC Contract
[ s4 GC Contract
[ s8 GC Contract
[ s9 GC Contract
[ s7 GC Contract

b. In the register, in the ‘Open As’ drop down list, select Collaborative or CPM Gantt, then
simply click on the schedule number or title link.

New V| Delete| Tools v| Sharing | Print ¥ | Export | Refresh Help

Find Results View | Standard v (o)1, W.F| Collaborative Gantt o4
] Number Title 4 Current State

[] ss GC Contract Archived Baseline

[ se GC Contract Archived Baseline

[ 32 GC Contract Archived Baseline

c. Open the schedule document by clicking on its number in the register. Then in the ‘Tasks’
section of the ‘Main’ page, click on either the ‘View Collaborative Gantt’ or ‘View CPM
Gantt’ buttons.
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General

SCHEDULE: GC Contract (32) =+ Archived Baseline

Main | Properties

Preview Active WBS Code Name DESCﬂptiDﬂ
view x WBS Code 1
View E x WBS Code 2
View ﬁ x WBS Code 3
view I X WBS Code 4
view I X WBS Code 5

=l TASKS

View Collaborative Gantt ... View CPM Gantt ... \ I

TASK SUMMARY

Current Percent 0

Complete

Estimated Remaining Duration 587

Estimated Start January 07, 2016
Estimated Finish April 06, 2018
Remaining Work 4]

Actual Work

o]

Note: Each Gantt view (Collaborative and CPM) enables you to work with tasks,
milestones, assignments, WBS Codes, etc. Although the two Gantts are very similar, you
can use the Collaborative Gantt to set baselines and approve schedules, and the CPM
Gantt to automatically recalculate schedules according to task dependencies.

Also, in Collaborative Gantt, all of your changes are saved immediately. In CPM Gantt,
you must click the Save button to save your changes. This feature in CPM Gantt enables
you to play with the schedule without updating the database.

9. To add tasks, summaries and milestones to your schedule, right click on the top level schedule
name, or on any existing task, summary or milestone. From the resulting list, choose ‘Insert
Task’, ‘Insert Milestone’, ‘Create Task’ or ‘Create Summary’.

Note: Insert Task adds a task with a default name and duration. Create Task allows you to
specify details about the task, and also allows creation of multiple tasks at one time
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Schedule: ‘Tast Schedule ‘ View: ‘ngress Tracking V‘ Filter: ‘*AII v‘ | E‘ E
EEHRE S e | @ CI [/ % e 22 8 2 2 (a3 S &
= Compl
b s e e s [2ow [ 2o [ 2o [ 2o [ zoe [ mm [ mm [ me [z [z [mw
&1 FrlTesl Schedule . O W ey O 2 ) 0.0 %
= Test Schdule Start a o 1 Dianuarv 01. 2919 0.0 %
& | L= Test Schedule nmsnb Rt 2025 i 005 &
Filter By Value 'Test Schedule Start"
Copy Milestone
Paste
Filter >
Group >
Sort >

Edit Links...

Insert Task CtrlsInsert
Insert Milestone

Create Task.

Create Summary...

Add/Edit Resource Assignment...  Cirl+A

Delete Cirl+D

Approve CtrlsEnter

Set/Remove Baseline...
Edit References...

Options..

10. Selecting ‘Create Task’ opens a separate Create New Task dialog box, where you can enter
information about the task. You can also choose to create multiple tasks in this dialog, as well as

creating links between the newly created tasks.

Create New Task

Name *

Number of Tasks * | 1

Estimated Start * Date F‘\"IEI\,Ir 30, 2019

Estimated Finish Date Ma\l’ 30, 2019

Duration of Tasks * | 1

|pays [v|

Create Finish-to-Start
Links Between Tasks

EA Time[s:00AM
[FC\ Time |5:00 PM

Responsible

Eusan Mills

Task Calendar |

E B

11. Once tasks are created, links can be edited or created by right-clicking a task and selecting ‘Edit

Links’.

12. To change the Gantt view (which columns appear to the left of the Gantt bars, how those columns
are sorted, etc), simply click on the ‘View’ dropdown list and select a view.
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dhedule: |Test Schedule |

I View: ‘ Progress Tracking

vl| Fitter: [*au v Ej]| %| Pl @|
EEEE 2 8E 9 @ T+ 52 [ 2 B[22 2] 2 . 2 b o[ B[ % 6
Task Name || Status | started | 2Pl Start
eted [ zo17 [ =018 2013 | 2020 | 2021 | 202z | 2023 2024 2025 2026 2027 |
% 1 FlTest Schedule * O [] Januaryo01,2019 | 0.0 %
T+ 2 ’—«Test Schedule Start ) O [] January 01,2018 0.0 % |
& 3| L Test Schedule Finish R O o, December 31, 2025 ! 0.0 % &

If your security permissions allow it, you can create your own views by clicking the ‘Gantt Views’

button

Schedule: ‘Test Schedule

| View: ‘Progress Tracking

v

Filter: [=all

v]

|_Eﬂ|%|.5'|@|

EEEEESZIER |[Nataral

] 22 [P e S [T o= & & Q 2 4:h i | B % 5

Task Name »| | status | started | <omP! Start
ete [ 2017 [ zo18 2019 [ 2020 | 2021 | 2022 | 2023 2024 | 2035 | 2026 2027
% 1 ElTest Schedule * | [0 |januaryoi, 2019 | 0.0 %
B [ Test Schedule Start N January 01, 2019
e - e[ 0 [0 e 000
o 3| - Test Schedule Finish e 0 [] , December 31,2025 || 0.0 % &

13. To change a task’s start date, end date or duration, either select a new date by clicking the
triangle in the lower right corner of a date field...

Task Name j Status | Started S Start Finizh
eted
[l Test Schedule - [ ] January 01, 2019 E)ecemher 31, 2025
= Test Schedule Start January 01, 2019 anuary 01, 2019
J ™ ] O | ry 01, . ry 01, )
= Test Schedule Finish - ] ] December 31, 2025 December 31, 2025
A A A

...or, in the Gantt chart, hover over the task bar in the Gantt chart, and when the bar changes
color, click and drag the bar left or right to change a task’s start and end date.

14. To change a task’s duration, hover the mouse over the right edge of the task bar, and when a
large red arrow head appears, click and drag it to the left or right.

GANTT VIEW BUTTONS & THEIR SCHEDULE FUNCTIONS

Schedule: ‘Test Schedule ‘

View: [Progress Tracking ~] | Fiter: [Fa v 3 & @ ||

e Go - Prefilter planning objects before they are displayed in the Gantt. Only available when “Use
Prefiltering” is selected in the Gantt Preferences.

e Edit Gantt Preferences - Displays the Gantt Preferences dialog box

e View - Allows you to control the columns displayed in the Gantt

[ ]

Filters - Allows you to narrow down the information displayed in the columns. Filters 2 & 3 appear
once you click the “Show Advanced Filters” button
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e Show Advanced Filters - Displays filters 2 and 3, as mentioned above.

e Manage Views - Enables you to customize the views available in the Gantt.

ElEEIEESEE S |[Natural B R R Y G RS T o= R 5

e Show Gantt Chart View - Displays chart and table

e Show Spreadsheet View - Displays the Gantt table and a Usage table for each planning object
as per period values.

e Show Combined View - Displays the Gantt chart, table and usage curves.

e Export - Allows you to export table information directly into Excel (requires Export Plug-in
installation).

e Row Specific Commands - Displays commands for the currently selected planning object. Also
enables you to perform actions such as Insert Task, Create Task, and Create Summary.

e Undo and Redo - Allows you to clear the last change you made or reapply the change you
cleared.

e Sort Order - Allows you to apply the sort order to the planning objects (for example “Sort by Task
Name”).

e Descending Sort Order - Allows sorting the planning objects in alphabetically descending order.

e Display Summaries, Milestones, Tasks - Toggles display of Summaries, Milestones, and Tasks
in the Gantt view

e Display Resources, Deleted, Links - Toggles display of Resources, Deleted Tasks, and Links,
in the Gantt view

e Display Approved, Baseline, Current — Toggles display of Approved, Baseline, Current task
bars.

e Rollup to Summary — Expands or collapses display of the child planning object summaries in the
parent summary in Gantt and Combined Views.

e Change Timescale - Used to display the desired time line in Usage chart. Choose D for days, W
for weeks, M for month, Q for quarters, or Y for years.

e Show Levels - Quickly expand or collapse planning object levels to the desired level. The “?”
enables you to choose a level from 0 to 9. The “*” expands all levels.

e (o to Selected Task - Used to scroll timescale to display the currently selected planning object.
This button is helpful if you've selected a task, then scrolled the Gantt up or down.
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e Zoom Selected Task - Used to adjust the timescale to the best fit for the selected planning
object in Gantt chart.

e Reschedule to Status Date - Used to reschedule all incomplete tasks and their assignments for
all dates prior to Status Date. When you click this button, the calendar appears. Choose the new
resume date for tasks. Note: rescheduling the incomplete tasks allows you to accurately reflect
their impact to the overall schedule.

e Chain Tasks - Creates Finish-to-Start links between the selected tasks, in the order that they
appear.

e Unchain Tasks - Deletes the links between selected tasks.

e Split Assignment - Splits the time that the task assignment is scheduled for. This enables you to
indicate that a task should start at a certain date that work may stop on it for a period of time and
that work shall resume at a later date.

e CPM Calculation - Turns the CPM calculation on or off. Available in CPM Gantt only.

GANTT TABLE & CHART ICONS

e A planning object is waiting to be approved.

e A planning object was modified after it was approved and needs to be re-approved.
e Information in a cell can be edited. Click this triangle to make the cell editable.

e The planning object contains references to ePM documents.

e A summary. The dark blue in the icon indicates that work has started in the summary.
e A summary with the milestones and tasks rolled up.

e A milestone. The milestone may also be approved or baselined. In this case, a second orange or
blue diamond appears behind this diamond.

e Atask has a current, baselined, or approved schedule. The current schedule is displayed in
green, the approved in blue, and the baselined in orange.

e A planning object is linked to another planning object.

e The lines between one part of the task and the next part indicate that the assignment has been
split.
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REFERENCES

Reference the following ePM Quick Reference Guides (QRGs) for additional information. QRGs can be
accessed through the ePM Portal.

e QRG 01 — Navigating ePM
e QRG 02 — Using the ePM Address Book
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